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DIABLO ANALYTICAL, INC. SOFTWARE LICENSE AGREEMENT AND LIMITED WARRANTY 

 

LICENSE AGREEMENT 

 

IMPORTANT:  Please carefully read the License Agreement below before installing the software.  The right to use this 

software product is sold only on the condition that the customer agrees to the following license.  INSTALLING THE 

SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS. 

 

In return for payment of the one-time license fee for this software product, Customer receives from Diablo Analytical, 

Inc. (Diablo) a license to use the product subject to the following terms and conditions: 

 

Use:  The product may be used one computer or workstation.  A separate license agreement and fee is required for each 

additional computer or workstation on which the product is used.  Customer may not reverse assemble, decompile, or 

modify the software. 

 

Copies:  The software product may not be duplicated or copied except for archive purposes, program error verification, 

or to replace defective media, and all copies made must bear the copyright notices contained in the original. 

 

Ownership:  Purchase of this license does not transfer any right, title or interest in the software product to Customer 

except as specifically set forth in this License Agreement.  Customer is on notice that the software product is protected 

under copyright laws. 

 

Transfer of Rights:  This license and the software product may be transferred to a third party, with prior written consent 

from Diablo, provided the third party agrees to all the terms of this License Agreement and the Customer does not retain 

any copies of the software product. 

 

Sublicensing and Distribution:  Customer may not sublicense the software or distribute copies of the software to the 

public in physical media or by telecommunication without the prior written consent of Diablo. 

 

Termination:  Diablo reserves the right to terminate this license upon breach.  In event of termination, Customer will 

either return all copies of the product to Diablo, or with Diablo's prior consent, provide Diablo with a certificate of 

destruction of all copies. 

 

Updates and Upgrades:  Customer agrees that the software does not include updates and upgrades which may be 

available from Diablo in a separate support agreement. 

 

Export Restrictions:  Customer agrees not to export or re-export the software or any copy in violation of the U.S. Export 

Administration regulations or other applicable regulation. 

 

LIMITED WARRANTY 

 

Limited Warranty:  Diablo warrants that the original disks are free from defects for 90 days from the date of delivery of 

the software. 

 

No Other Warranties:  To the maximum extent permitted by applicable law, Diablo expressly disclaims any warranty for 

the software product.  The software product and any related documentation is provided "as is" without warranty of any 

kind, either express or implied, including, without limitation, the implied warranties or merchantability of fitness for a 

particular purpose.  The entire risk arising out of use or performance of the software product remains with the customer. 

 

Limitation of Liability and Customer Remedies:  Diablo's entire liability and the customer's exclusive remedy under this 

license agreement shall be, at Diablo's option, either (a) return of the price paid for the software or (b) replacement of the 

software that does not meet Diablo's Limited Warranty and which is returned to Diablo with a copy of the customer's 

receipt.  Any replacement software will be warranted for the remainder of the original warranty period, or 30 days, 

whichever is longer.  These remedies are not available outside the United States of America. 

 



 

 

No Liability for Consequential Damages:  To the maximum extent permitted by applicable law, in no event shall Diablo 

be liable for any damages whatsoever (including, without limitation, damages for loss of business profit, business 

interruption, loss of business information, or any other pecuniary loss) arising out of the use or inability to use the 

product, even if Diablo has been advised of the possibility of such damages.  Because some states/jurisdictions do not 

allow the exclusion or limitation of liability for consequential or incidental damages, the above limitation may not apply 

to you. 
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BLM Onshore Supplement 

Introduction 
This document is a supplement to the standard EZReporter 4.0 reference manuals and other documentation.  It outlines 

the features and configuration settings that can be used to aid in complying with portions of the new “BLM Onshore” 

regulations.  Specifically, 43 CFR Part 3170 (Title 43. Subtitle B. Chapter II. Subchapter C. Part 3170, Subpart 3175), 

relating to Onshore Oil and Gas Production and Measurement of Gas. 

Each section below includes excerpts from the relevant sections and paragraphs of the regulation as a convenience.  The 

regulations in this document are current as of 2/16/2017. 

Important:  You should refer to the full text of the current version of the regulation to confirm that you are in 

compliance.  The excerpts below only include the sections and paragraphs pertinent to the discussion of the relevant 

EZReporter functionality. 

The full text of the regulation is available online using “eCFR”, the Electronic Code of Federal Regulations: 

http://www.ecfr.gov 

Important Disclaimer 

Diablo Analytical provides this supplement, related software features and functionality, and configuration templates in 

good faith as a courtesy to our customers.  However, it is the customer’s responsibility to ensure that they are in 

compliance with all federal regulations and that the data and reports they submit are accurate and complete. 

Please review the License Agreement and Limited Warranty displayed at the beginning of the printed manual for 

Diablo’s limits on liability. 

Technical Support 

Contact Diablo Analytical for EZReporter technical support: 

Diablo Analytical, Inc. 

5141 Lone Tree Way 

Antioch, CA  94531 

Phone: (925) 755-1005 

Fax: (925) 755-1007  

Electronic Mail 

Use our dedicated support address for e-mail based technical support: 

support@diabloanalytical.com 

http://www.ecfr.gov/
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World Wide Web 

Access online support resources on our web site: 

http://www.diabloanalytical.com/support.htm 

Software Requirements 

You must be running EZReporter Version 4.0.8.0 or later to access some of the features and functionality described in 

this supplement.  Some of the functionality described in this supplement also requires the Results Database Module to be 

licensed and activated.  If you want to take advantage of that functionality you will need to add the Results Database 

module to your license.  Please contact Diablo Analytical for a quotation. 

Automatic Upgrade 

If you are running version 4.0.4.1 or later, you can download and install the correct version of the software automatically 

using the “Check for Updates” option of the “Help” menu. 

Manual Upgrade 

If you are running an older version of EZReporter 4.0, simply download the installation program from the EZReporter 

download page: 

https://diabloanalytical.com/products/software/ezreporter/#downloads 

IMPORTANT: Make sure you download the installer that includes support for the chromatography data system you are 

using.  Contact Diablo Analytical if you are using a chromatography data system that isn’t listed on the download page. 

NOTE: The “web” version of the installer can be used to upgrade an existing installation even if the computer doesn’t 

have Internet access. 

Your current version of EZReporter will be uninstalled and the new version installed automatically and your license 

status will be preserved. 

Definitions and Acronyms 

The following definitions and acronyms are excerpted from 43 CFR 3175.10.  Please refer to the actual text of the 

regulation for the full list of definitions and acronyms. 

Very-low-volume facility measurement point or very-low-volume FMP:  means any FMP that measures 
35 Mcf/day or less over the averaging period. 

Low-volume facility measurement point or low-volume FMP:  means any FMP that measures more than 
35 Mcf/day, but less than or equal to 200 Mcf/day, over the averaging period. 

High-volume facility measurement point or high-volume FMP:  means any FMP that measures more than 
200 Mcf/day, but less than or equal to 1,000 Mcf/day over the averaging period. 

Very-high-volume facility measurement point or very-high-volume FMP: means any FMP that measures 
more than 1,000 Mcf/day over the averaging period. 

Heating value variability:  means the deviation of previous heating values over a given time period from the 
average heating value over that same time period, calculated at a 95 percent confidence level. Unless 
otherwise approved by the BLM, variability is determined with the following equation: 

 

Where: 

V95%= heating value variability, % 

σHV= standard deviation of the previous 5 heating values 

https://diabloanalytical.com/products/software/ezreporter/#downloads


 

Diablo EZReporter 4.0 BLM Onshore Supplement BLM Onshore Supplement    3 

2.776 = the “student-t” function for a probability of 0.05 and 4 degrees of freedom (degree of freedom is the number of 
samples minus 1) 

HV= the average heating value over the time period used to determine the standard deviation 

BLM Onshore Regulation Discussion 
The specific sections, paragraphs, and items from the BLM Onshore regulations that pertain to reporting functionality 

that can be provided by EZReporter, are listed in the following sections.  Each section starts with an excerpt from the 

current version of the regulation, and is followed by a discussion of the relevant EZReporter functionality and how to 

configure and use it. 

BLM Onshore Configuration Templates 

As a courtesy, we have created two new configuration templates that already incorporate most of the settings that follow 

below.  You can create a new configuration file from one of these templates to use as a starting point. 

1) Click the “File > New Configuration File…” main menu option to display the New Configuration File Wizard. 

2) Choose the option to “Browse other configuration template files not listed above” and then click “Next”. 

 

 

3) Browse and select one of the following templates: 

 

For Hexanes Plus (C6+) methods:  BLM Onshore.C6+.GPA 2145-16.cfgt 

For extended analysis methods:  BLM Onshore.Extended.GPA 2145-16.cfgt 

4) You can then further customize the configuration file to meet your individual needs. 
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3175.31 Specific Performance Requirements 

3175.31 (b)(1-3) Heating Value Uncertainty levels 

Excerpt from Regulation: 

(b) Heating value uncertainty levels. (1) For high-volume FMPs, the measuring equipment must achieve an annual 
average heating value uncertainty within ±2 percent. 

(2) For very-high-volume FMPs, the measuring equipment must achieve an annual average heating value 
uncertainty within ±1 percent. 

(3) Unless otherwise approved by the AO, the average annual heating value uncertainty must be determined as 
follows: 

 

 

EZReporter Discussion: 

Important:  The following requires the Results Database module to be licensed and activated. 

You can use the EZReporter Results Database to retrieve the previous 12 months of results and calculate the average and 

standard deviation of the heating value over that period. 

Important:  The results database uses the Sample Name from the results provided by the chromatography data system to 

identify a particular meter/FMP.  So, make sure to be consistent with the sample names you enter when setting up 

runs/sequences in the chromatography data system. 

Note: the BLM Onshore regulations require a very specific formula for calculating the heating value uncertainty.  

EZReporter is not able to perform this calculation at this time.  However, you can use the average and standard deviation 

reported by EZReporter as the basis for the calculation of uncertainty in Microsoft Excel or some other software. 

To retrieve the last 12 months of results for a particular FMP, click the “Find Results” button located at the bottom of the 

main Results Database Window: 

1) Select the Sample Name corresponding to the FMP. 

2) Check “Enable Date Filter” and choose “Injection Date” as the Data Source. 

3) In the “Date Range” section, enter “12”, select the range of “Months”, and then click the “Apply” button.  The 

“Start Date” and “End Date” will be set to the previous 12 months. 

4) Click the “Find” button. 
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All results for the specified Sample Name that were saved during the last 12 months will be displayed along with the 

Average and Standard Deviation for those results. 

 

The GrossHeatingValueRealDry Average and Standard Deviation, along with the Number of Results displayed at the top 

of the summary window can be used to calculate the Heating Value Uncertainty using the formulas defined in the 

regulations.  See “Heating value variability” in “Definitions and Acronyms” on page 2 and the “Heating value 

uncertainty” formula in the excerpt from the regulations above. 
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3175.113 Spot Samples – General Requirements 

3175.113 (c)(5) Minimum number of samples and analyses 

Excerpt from Regulation: 

(5) Minimum number of samples and analyses.(i) For low- and very-low-volume FMPs, at least three samples must 
be taken and analyzed; 

(ii) For high-volume FMPs, samples must be taken and analyzed until the difference between the maximum heating 
value and minimum heating value calculated from three consecutive analyses is less than or equal to 16 Btu/scf; 

(iii) For very-high-volume FMPs, samples must be taken and analyzed until the difference between the maximum 
heating value and minimum heating value calculated from three consecutive analyses is less than or equal to 8 Btu/scf. 

EZReporter Discussion: 

Important:  The following requires the Results Database module to be licensed and activated. 

For all FMP volume classifications, a minimum of 3 samples must be taken and analyzed.  You can set up the Results 

Database Processing options so that the results for the last three samples with the current sample name are displayed 

automatically at the end of the run. 

Important:  The results database uses the Sample Name from the results provided by the chromatography data system to 

identify a particular meter/FMP.  So, make sure to be consistent with the sample names you enter when setting up 

runs/sequences in the chromatography data system. 

Set up the “Results Database”, “Results Data Processing” section of the configuration editor as shown below 

1) Check “Save automatically processed results to the Results Database 

2) Check “Add components with raw amount of 0 to database”.  This is important to ensure that all samples are 

included in the calculation of average and standard deviation. 

3) Check “Display Sample History” and set the Limit to “3” Results. 
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When you process results, each sample will be added to the results database, and the last three samples with the current 

sample name will be displayed along with summary statistics: 

 

Low-Volume and Very-Low-Volume FMPS 

For Low-Volume and Very-Low-Volume facility measurement points (FMPs), you must take three consecutive 

measurements, and then you can report the result as either the mean (average) of all 3 samples or the results for the 

median (middle) sample. 

High-Volume FMPs and Very-High-Volume FMPs 

For High-Volume and Very-High-Volume facility measurement points (FMPs), samples must be run until the range 

between the maximum and minimum Gross Heating Value is less than 16 BTU/scf. (High-Volume) or 8 BTU/scf (Very-

High-Volume) for three consecutive measurements. 

The results database sample results summary displays the range (maximum-minimum) of the Gross Heating Value (Real, 

Dry).  Once the range meets the limit for the FMP volume classification (16 or 8 BTU/scf), you can report the result as 

either the mean (average) of all 3 samples or the results for the median (middle) sample. 

 

3175.113 (c)(6) Heating Value and Relative Density Reporting 

Excerpt from Regulation: 

(6) The heating value and relative density used for OGOR reporting must be: 

(i) The mean heating value and relative density calculated from the three analyses required in paragraph (d)(5) of 
this section; 
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(ii) The median heating value and relative density calculated from the three analyses required in paragraph (d)(5) of 
this section; or 

(iii) Any other method approved by the BLM. 

EZReporter Discussion: 

Mean/Average Value of 3 runs 

To report the mean (average) value of the 3 runs, check the “Select” checkbox for all three samples:  

 

Then click the “Report Result” button at the bottom of the Results Database window.  In the “Report Options” window, 

select “Average of selected (checked) results” and click OK. 

 

The results for the 3 runs will be averaged and then reported to the main Sample Results window.  You can then print the 

report, export it to a text file and perform any other reporting activity that you would for a normal report. 

Median (Middle) Value of 3 runs 

To report the median (middle) result, you need to examine the GrossHeatingValueRealDry results and find the value 

that is the middle of the three and select that row so it is highlighted. 

Important: “Median” refers to the middle value, not the middle run! 
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Then click the “Report Result” button at the bottom of the Results Database window.  In the “Report Options” window, 

select “Currently selected result” and click OK. 

 

The selected median results will reported to the main Sample Results window.  You can then print the report, export it to 

a text file and perform any other reporting activity that you would for a normal report. 

3175.118 Gas Chromatograph Requirements 

3175.118 (b) Un-normalized Mole% 

Excerpt from Regulation: 

(b) Samples must be analyzed until the un-normalized sum of the mole percent of all gases analyzed is between 97 and 
103 percent. 

EZReporter Discussion: 

You can create a “monitored parameter” with an alarm to alert you to whether a particular analysis meets this 

requirement. 

1) Open the EZReporter configuration editor and switch to the “General Settings”, “Monitored Parameters” 

configuration panel. 

2) Click the “Add” button to add a new parameter, and then in the “Options” tab configure the parameters as 

follows: 
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a. Parameter: select “Total Raw Mole% 

b. Set the Parameter Display Name to, “Total Un-normalized Mole%” 

c. Click the “Set Default” button to set the default number of decimal places to display for the result. 

 

 

3) Switch to the “Alarms” tab and set the following options: 

a. Check “Enable High Alarm” and “Enable Low Alarm” 

b. Set the Alarm Type to “Fixed Alarm Limits” 

c. Set the Fixed Upper Alarm Limit to 103 
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d. Set the Fixed Lower Alarm Limit to 97 

 

 

4) When a sample is processed from the chromatography data system, the total un-normalized amount will be 

displayed in the parameter table on the “Parameter Monitor” tab of the main program window.  The status will 

indicate whether the value falls within the required range. 

 

 

You can also configure EZReporter to include a parameter report when printing the sample results report as follows: 

1) Click the “Options” button located on the Monitored Parameters panel of the configuration editor. 

2) Check “Display Alarm Limits and Status” 

3) Check “Print Parameter Report” 
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3175.118 (c)(5) GPA 2261 Reproducibility 

Excerpt from Regulation: 

(5) If the composition of the gas used for verification as determined by the GC varies from the certified composition of the 
gas used for verification by more than the reproducibility values listed in GPA 2261-13, Section 10 (incorporated by 
reference, see §3175.30), the GC must be calibrated under GPA 2261-13, Section 6 (incorporated by reference, see 
§3175.30). 

EZReporter Discussion: 

Click, the “Tools > Edit Standard Amounts” menu option and enter a description for your calibration/validation standard 

along with the certified amounts for each component in the standard: 

Note: The Standard Amounts are linked to the particular configuration file loaded at the time they are entered.  You will 

need to re-enter the description and amounts if you load a different configuration file or rename the current configuration 

file. 
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After running your verification sample, click the menu option, “Tools > Compare with Standard…”  Make sure 

Comparison Method is set to “GPA 2261-13” and the Comparison Type is “Reproducibility”. 

 

The relative percent difference (%Diff) and Reproducibility will be calculated for each of the components and the 

“Status” will be updated to indicate whether the measured component amount falls within the GPA 2261-13 

reproducibility limits for the component. 
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You can click the “Print” button to print a verification report to save with your records. 

3175.118 (d)(1-6) Verification Documentation 

Excerpt from Regulation: 

 (d) The operator must retain documentation of the verifications for the period required under §3170.6 of this part, 
and make it available to the BLM upon request. The documentation must include: 

(1) The components analyzed; 

(2) The response factor for each component; 

(3) The peak area for each component; 

(4) The mole percent of each component as determined by the GC; 

(5) The mole percent of each component in the gas used for verification; 

(6) The difference between the mole percents determined in paragraphs (d)(4) and (5) of this section, expressed in 
relative percent; 

EZReporter Discussion: 

You can use a combination of the standard EZReporter printed report (items 1,2,3,4) and the printed verification report 

(items 1,4,5,6) to document the verification run. 

Important Note about Item 2, Response Factor:  The “Response Factor” reported by EZReporter is calculated from 

the un-normalized amount and peak area as reported by the chromatography data system (amount/area).  This value only 

represents the actual response factor used by the data system for single-level calibrations.  EZReporter does not import 

the actual response factors from the data system. 

3175.119 Components to Analyze 

3175.119 (a)(1-9) C6+ Components 

Excerpt from Regulation: 

(a) The gas must be analyzed for the following components: 

(1) Methane; 

(2) Ethane; 

(3) Propane; 

(4) Iso Butane; 

(5) Normal Butane; 

(6) Pentanes; 

(7) Hexanes + (C6+); 

(8) Carbon dioxide; and 

(9) Nitrogen. 

EZReporter Discussion: 

The BLM Onshore.C6+.GPA 2145-16.cfgt configuration template contains this list of components and the 

corresponding GPA 2145-16 physical constants.  See “BLM Onshore Configuration Templates” on page 3 

Note:  The Hexanes Plus physical constants used in this configuration template are based on a composition (split) of 

60% nC6, 30% nC7, and 10% nC8.  See “3175.119 (c) Adjusting C6+ Composition (Split)” on page 15 for instructions 

on updating the C6+ physical constants based on a different composition. 
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Important:  In order for EZReporter to identify the results for a particular component, the component name in the 

EZReporter component table must match the spelling of the component name reported by the chromatography data 

system. 

3175.119 (b)(1-4) Extended Components 

Excerpt from Regulation: 

(b) When the concentration of C6+ exceeds 0.5 mole percent, the following gas components must also be analyzed: 

(1) Hexanes; 

(2) Heptanes; 

(3) Octanes; and 

(4) Nonanes +. 

EZReporter Discussion: 

The BLM Onshore.Extended.GPA 2145-16.cfgt configuration template contains these additional extended components 

and the corresponding GPA 2145-16 physical constants.  See “BLM Onshore Configuration Templates” on page 3 

Note:  The physical constants used for these extended groups are those of the corresponding n-alkane (n paraffin): 

n-Hexane -> Hexanes; n-Heptane -> Heptanes; n-Octane -> Octanes; n-Nonane-> Nonanes 

Important:  In order for EZReporter to identify the results for a particular component group, the component name in the 

EZReporter component table must match the spelling of the component group name reported by the chromatography 

data system. 

3175.119 (c) Adjusting C6+ Composition (Split) 

Excerpt from Regulation: 

(c) In lieu of testing each sample for the components required under paragraph (b) of this section, the operator may 
periodically test for these components and adjust the assumed C6+ composition to remove bias in the heating value (see 
§3175.126(a)(3)). The C6+ composition must be applied to the mole percent of C6+ analyses until the next analysis is 
done under paragraph (b) of this section. The minimum analysis frequency for the components listed in paragraph (b) of 
this section is as follows: 

(1) For high-volume FMPs, once per year; and 

(2) For very-high-volume FMPs, once every 6 months. 

EZReporter Discussion: 

Instead of testing each sample for the extended components, this option allows you to adjust the assumed C6+ 

composition based on a periodic extended analysis of the composition.  By default, the C6+ component constants are 

based on an assumed composition (split) of 60% nC6, 30% nC7, and 10% nC8.  To change to a different composition: 

1) Click the “Std Components” button located below the component table in the configuration editor. 

2) Select (check) the extended components you want to include in the composition calculation. 

3) Right click the table and select, “Create Combined Component” from the pop-up menu. 

 



 

16    BLM Onshore Supplement Diablo EZReporter 4.0 BLM Onshore Supplement 

 

 

In the “Create Combined Component” window, do the following: 

1) Change the “Combined Component Name” to match the name you are using for Hexanes Plus in your 

component table. 

2) Select the “Weighted Properties” option. 

3) Enter the weighting percentages for each component based on the new extended analysis. 

 

 

Click “Transfer” to calculate and transfer the new physical constants to the Hexanes Plus component in your component 

table: 
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If you named the combined component so it matched your Hexanes Plus component name, then Hexanes Plus will have 

been updated with the physical constants based on the new composition. 

 

If you have a custom sample information field in that reports the composition of the C6+ split, then you should update it 

to reflect the new split.  See “3175.120 (a)(1-25) Sample Information” on page 17 

3175.120 Gas Analysis Report Requirements 

3175.120 (a)(1-25) Sample Information 

Excerpt from Regulation: 

(a) The gas analysis report must contain the following information: 

(1) The information required in §3170.7(g) of this part; 

(2) The date and time that the sample for spot samples was taken or, for composite samples, the date the cylinder 
was installed and the date the cylinder was removed; 

(3) The date and time of the analysis; 

(4) For spot samples, the effective date, if other than the date of sampling; 

(5) For composite samples, the effective start and end date; 
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(6) The name of the laboratory where the analysis was performed; 

(7) The device used for analysis (i.e., GC, calorimeter, or mass spectrometer); 

(8) The make and model of analyzer; 

(9) The date of last calibration or verification of the analyzer; 

(10) The flowing temperature at the time of sampling; 

(11) The flowing pressure at the time of sampling, including units of measure (psia or psig); 

(12) The flow rate at the time of sampling; 

(13) The ambient air temperature at the time of sampling; 

(14) Whether or not heat trace or any other method of heating was used; 

(15) The type of sample (i.e., spot-cylinder, spot-portable GC, composite); 

(16) The sampling method if spot-cylinder (e.g., fill and empty, helium pop); 

(17) A list of the components of the gas tested; 

(18) The un-normalized mole percents of the components tested, including a summation of those mole percents; 

(19) The normalized mole percent of each component tested, including a summation of those mole percents; 

(20) The ideal heating value (Btu/scf); 

(21) The real heating value (Btu/scf), dry basis; 

(22) The hexane+ split, if applicable; 

(23) The pressure base and temperature base; 

(24) The relative density; and 

(25) The name of the company obtaining the gas sample. 

EZReporter Discussion: 

You can use a combination of standard EZReporter results (Sample Information, Component, and Total/Summary 

Results), and Custom Sample Information Fields to include the required information in your report. 

Note:  The BLM Onshore configuration templates are already set up with these sample information items.  See “BLM 

Onshore Configuration Templates” on page 3 

The following table lists the items required in this section of the regulation, the type of result, and the specific result that 

needs to be enabled.  In addition to the items listed in the table, there are other results you will need to include in the 

reports (for example, Sample Name, which should correspond to the meter number or other identifier for the FMP, and 

the component peak area, and response factor for verification reports). 

 

Item Result Type Result 

(2) The date and time that the sample for 
spot samples was taken or, for composite 
samples, the date the cylinder was installed 
and the date the cylinder was removed; 

Custom Sample Information Field  

(3) The date and time of the analysis; Sample Information Result Injection Date 

(4) For spot samples, the effective date, if 
other than the date of sampling; 

Custom Sample Information Field  

(5) For composite samples, the effective 
start and end date; 

Custom Sample Information Field  

(6) The name of the laboratory where the 
analysis was performed; 

Custom Sample Information Field  
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(7) The device used for analysis (i.e., GC, 
calorimeter, or mass spectrometer); 

Custom Sample Information Field  

(8) The make and model of analyzer; Custom Sample Information Field  

(9) The date of last calibration or verification 
of the analyzer; 

Custom Sample Information Field  

(10) The flowing temperature at the time of 
sampling; 

Total/Summary Results Flowing Temperature  
(you must also check “Prompt for 
Flowing Temperature and 
Pressure” in the NGA 
Configuration.) 

(11) The flowing pressure at the time of 
sampling, including units of measure (psia or 
psig); 

Total/Summary Results Flowing Pressure  
(you must also check “Prompt for 
Flowing Temperature and 
Pressure” in the NGA 
Configuration.) 

(12) The flow rate at the time of sampling; Custom Sample Information Field  

(13) The ambient air temperature at the time 
of sampling; 

Custom Sample Information Field  

(14) Whether or not heat trace or any other 
method of heating was used; 

Custom Sample Information Field  

(15) The type of sample (i.e., spot-cylinder, 
spot-portable GC, composite); 

Custom Sample Information Field  

(16) The sampling method if spot-cylinder 
(e.g., fill and empty, helium pop); 

Custom Sample Information Field  

(17) A list of the components of the gas 
tested; 

Component Results All components/component 
names in the component table are 
reported automatically. 

(18) The un-normalized mole percents of the 
components tested, including a summation 
of those mole percents; 

Component Results Component Raw (un-normalized 
amount) 

(19) The normalized mole percent of each 
component tested, including a summation of 
those mole percents; 

Component Results Component Normalized% 

(20) The ideal heating value (Btu/scf); Total/Summary Results Gross Heating Value, Vol (Ideal) 

(21) The real heating value (Btu/scf), dry 
basis; 

Total/Summary Results Gross Heating Value, Vol (Real) 

(22) The hexane+ split, if applicable; Custom Sample Information Field  

(23) The pressure base and temperature 
base; 

Total/Summary Results Pressure Base and Temperature 
Base 

(24) The relative density; and Total/Summary Results Relative Density (G), Real 

(25) The name of the company obtaining the 
gas sample. 

Custom Sample Information Field  

Standard Results: 

To include any of the standard results (Sample Information, Component, or Total/Summary) in the report, switch to the 

“Report Settings” and “Reported Results’ section of the configuration editor and simply check those results you want to 

appear in the report.  The table is divided into three sections:  Sample Information results at the top, Component Results 

in the middle, and Total/Summary results at the bottom. 
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Custom Sample Information Fields: 

To add custom sample information fields to your report, switch to the “General Settings” and “Sample Information” 

section of the configuration editor. 

1) Check “Enable Custom Sample Information Field” 

2) Click the “Add” button and then enter the caption you want to appear on the report. 

3) If there is a default value you always want to appear in the report (like company name), you can enter the 

default value. 

4) There is a special form of default value you can use to display a list of values to choose from.  Set the "Default" 

value to the list of items separated by the "pipe" character (|).  The list must start with "<" and end with ">".  If 

you place a pipe character immediately after "<", then a combo box is used display the list, allowing the user to 

enter any text.  For example, <|Item 1|Item 2|Item 3>.  Otherwise, a list box is displayed and the user can only 

select from the listed items.  For example, <Item 1|Item 2|Item 3>. 

5) If you want the last value entered to be recalled the next time the manual data entry prompt is displayed, then 

you can check the “Recall” checkbox. 
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Flowing Temperature and Pressure: 

Flowing Temperature and Pressure are special cases.  In addition to enabling those results in the report configuration, 

you also need to check “Prompt for Flowing Temperature and Pressure” in the “Natural Gas Anlaysis”, “NGA Settings” 

section of the configuration editor. 

While you are enabling the flowing temperature and pressure, you should also confirm that the Base Pressure is set to 

14.73 as required by the regulations. 
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Manual Data Entry 

When processing results from the chromatography data system, the Manual Data Entry window will be displayed 

automatically, allowing you to enter the information that will be displayed in the report. 
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3175.120 (c) Heating Value and Relative Density Calculations by API 14.5 

Excerpt from Regulation: 

(c) The heating value and relative density must be calculated under API 14.5 (incorporated by reference, see §3175.30). 

EZReporter Discussion: 

EZReporter performs natural gas analysis calculations according to the GPA 2172 standard, which is the same as API 

14.5. 
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